Step 1: Formatting text
1. Font: Times New Roman
2. Size: 
Article text: size 10
Headline (title): size 14, bold, italics.
3. [bookmark: _GoBack]Margins:
· Click on the “page layout” tab
· Click on margins
· Click on narrow
[image: ]
4. Remove spacing between paragraphs
· Highlight article text
· Click on “Home” tab
· Click on “Line and paragraph spacing”
· Click on “Remove spacing after paragraph”
· [image: ]


5. Columns: 3 columns
· Highlight article
· Click on the “Page Layout” tab
· Click on “columns”
· Click 3 columns 
[image: ]
6. Justify:
· Highlight article text
· Click on home tab
· Click “justify” in the paragraph section
[image: ]


Step 2: Pictures
1. Photo
· Copy and paste your picture into your document (or insert photo)
· Right click on the photo 
· Go to “wrap text”
· Click on “Tight”
· Place your photo where you want it in your document – your text will wrap around it
· [image: ]
2. Byline photo
· Insert your photo from your file. 
· Right click on photo
· Go to “Wrap Text”
· Click on “In line with text”
· Place photo between subheading and byline (name)
[image: ]


Cropping photo: If your picture has more than one person, or is more than just your face you need to crop it so that it is just your face. 
· Click on photo
· Click on the tab “Picture tools – Format”
· On the right hand side, click on “Crop”
· Crop your photo by bringing the black corners to surround your face.
· Click away from the picture and only the portion that you selected will remain.
[image: ]
Step 3: Call-out: A call out is an eye-catching statement from your article that will draw your reader in. It can be either an alarming statistic, a powerful quote from your interview, or a part of your writing that you think will hook the reader.
· Click on the “Insert” tab
· Click on “text box”
· From the drop down options that you have, select “simple text box”

[image: ]

· Find a quote from your article (your writing, not lyrics from the song) and copy it into the text box
· Make the font  size 14 so it will stand out on the page. 
· Click on the text box
· Click on the “text box tools – format” tab
· Click on “Wrap text” (on the right”
· Click on “tight”
[image: ]
· Place the call-out in your article between the columns to make it stand out
Step 4: Finishing
· Adjust the size of the picture and call-out to your article fits nicely on one page. 
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Born to Run response draft - Microsoft Word

File Home | Insert  Pagelayout  References  Mailngs  Review  View Format o
% cut - " N # Find -
Times NewRomi = 10« A" x| As- | % P ¢ C AaB
. AaBbCcDd AaBbCcDd AaBhCc ab . 2, Replace
Paste B I U - . WA L B P _ | Change
- < Format Painter = R = = N * | styles - | v select
Clipboard 5 Font Paragraph Styles Editing
towards my goals. . z
Tl never forge the fit time I fesrem + @ @ -
heard this song. 1 think about it 3
every time T hear i. It was one Jesam 5 -
of the fist songs I leamed how
to play on guitar and the firt
song I performed in public. It & cut
was the first song that mad me T
feel hope, it was the first time 2 =
song changed my ife [ Paste Options:
@
Save as picture
¥z Change Picture, B In Line with Text
5t v square
% Bringtofront | > Tt
% sendtoBack | |G Through
& Hyperlink. [ Top and Bottom
Insert Caption. B Behind Text 3
@ InFront of Text B
o
[E size and position. o Edit wrap Points .
Page: 2 of 2 | Words: 788 | < English (Canada) | % Format Picture. = More Layout Options. Iy} )





image6.png
Wd9-0|-

Born to Run response draf

Microsoft Word

File Home | Insert | Pagelayout References  Mailngs  Review  View Format
| . @ D a gl @, Hyperlink j j j A j Al [& signature Line - A=
B D2 @ Xy W
j ' ws U o A Bookmark 3 Date & Time
Cover Blank Page | Table Clip ~ Shapes Smartart Chart Screenshot . . | Header Footer Page | Ted Quick WordArt Drop . Equation Symbol
Page~ Page Break | - At S e -~ Number-| Box- Paris- - cap- ‘48 Object~ -
Pages Tables llustrations Links Header & Footer Text symbols
Insert Picture from File @
Insert a picture from a file. e
D Press F1 for more help.
Bornto Run...or didn't discourage my reactionto yowre young' represented

Stay?

The song that

changed mylife

“Tiffany Dickie

“1 wanna know if love is wild,
babe T wanna know if love is
real” I stil remember the first
time 1 heard Springsteen sing
these lyrics from “Bom to Run”
I was backstage at the HSB
variety show listening to my

this Ene. Then again... look at
that man, I mean really, it's
Springsteen!

I was fifteen years old and
longing to be anywhere but my
high school in a city that 1
thought was too small to contain
me; a city too small to contain
an ant! It made me feel bke
there was so much out there for
me to experience if I could just
escape!

Unfortunately, being fifteen in
2 close community meant that
you  couldnt escape
ourself! You can't go anywhere

everything I waslonging for.

1 wanted to move away from
the small town high school out
into a world of wonder and
opportunity! From that night on,
Tbelieved that I was bom to nun,
and needed to run as far as 1
could away from that town,

As fime went by, this song
stayed with me as an anthem to
survival. If I could just survive
whatever task or joumey that
was expected of me, I would
escape the constraints of my lfe.

My rebel subconscious kept

dise man. Yes, one of those ithout someone knoving you replaying the image of me E
large devices that you had to o your parents, which made driving into the sunset on the .
actually put a CD in and aying to re nvent yourslf very back of a Harley escaping that N
sequired batteries, not charging @fficult. T thought 1 would never small tovm and the rumors and :
- - gossip that develop withinit. My
Page: 1 of 2 | Words: 788 | < English (Canada) | Iy (+)





image7.png
File Home Insert  Pagelayout References  Malings  Review

View

Format

orn to Run Reflective article example [Compatibility Mode] M.

% Brightness - J3 Compress Pictures

Contrast g Reset Picture
4 Recolor -
Adjust

Q7. ¢

Shadow

£%0,
Effects ~ 9
Shadow Effects Border

B =

Position Wrap

Text +

Arrange

size

£ Height: 344 cm

2 Width: 3.94 cm

Born to Run... or Stay?
The song that

changed my life

Tiffany Dickie

“I wanna know if love is wild,
‘babe I wanna know if love is real”
T stil remember the fst time T heard
Springsteen sing these Iyrics from “Bom
to Run”. T was backstage at the HSB
variety show listening to my disc man.
Yes, one of those large devices that you
had to actually put a CD in and required
bateries, not charging,

Position the pointer over any handle and drag to crop.

that T thought was too small to
contain me; a city too smallto
contain an ant! It made me feel
ke there was so much out there
for me to experence if I could
Just escape!

Unfortunately, being fiteen in
2 dlose community meant that
you coudn’t even escape
yousdfl  You camt g0
anywhere without _someone
knowing you or your parents,
which made tying to re nvent
yourself very difficult. 1 thought
T would neves lose the “good
" rep,no matter what 1 did!

Being
badass
wasn't my
goal, T just
wanted to
stop being
asked if 1
was the

ow while you're young” represented
everything I was longiag for.

T wanted to move away from the small
towm bigh school out into 2 word of
wonder and opportunity! From tht ight
on, T belieed that I as bom to run, and
neededto run asfaras1 coud away from
thattowm

s time weat by, this song stayed with
me 25 an anthem to survival 1 could
Just survive whatever task orjoumey that
was expected of me, I would escape the
constraints of my life.

My rebel subconscious kept replaying
the image of me diving into the sunset
on the back of a Haley escaping that

small town and

the mumors and
gossp that
develop ithin it
My rebel
subconscious
apparently  did
not realize the
horble  helmet

[ w ]» &0




image8.png
Born to Run Reflective article example [Compatibility Mode

Home | Insert | Pagelayout References  Malings  Review  View

EHE ,{—;» . @, Hyperlink A A A= (& sSignature Line -
g0 bd B8 @ 2 @ [ Q
A& Bookmark [ Date & Time
Cover Blank Page | Table | Picture Clip Shapes Smartart Chart shot | - . Header Footer Page | Ted Quick Wordat Drop .
Page - Page Break | - At - [ Cross-reference | """ Number - | Box~ Parts- - cap- " Oblect-
Pages Tables llustrations Links Header & Footer | Built-n |
Born to Run... or Stay? there for me to experience if T
could just escape!
The song that Unfortunately, being ffteen in
3 close community meant that
’ ou couldnt even escape
changed my life ’ :
changed my life yousdlfl  You cam't g0 Simple Text Box ]
. e Simple text box it the defaut
kmoving you or your parents, B o e ‘Alphabet Sidebar
) which made tying to re-invent ormatting
) ‘i"‘w"”‘“"":“mh*“";“f;:: @) Functionality is currently limited.
his docurpent; has been opened in
1o matter what I &id!
N g’ rep. 10 Compatibility Mode. To take full
ftany Dickae Dang advantage of this feature, convert
“I wanna know if love is wild, “"".t y );uur‘ d::urr(\:ni;lo ?a .:w fd\\;‘furmat
e R s y clicking the File tab and then
‘babe I wanna know if love is real’ goal, Tjust chcing Cawert
T stil remember the fst time T heard vanted to
Springsteen sing these Iyrics from “Bom stop being Press F1 fof migtee
to Run”. T was backstage at the HSB asked if T =
vatiety show lstening to my disc man. s the “Annual Quote ‘Annual Sidebar ‘Austere Quote v
Yes, one of those large devices that you “new gl
had to sctually put a CD in and required o omy | ®  More Text Boxes from Office.com >
batteries, not charging. Sourth year
My dad had lent me Springsteen’s of being in Draw Text o
Greatest Hits album so 1 had something that school.
10 Tisten to_other than the cherleaders Trving_to

Page: 1 of 1 | Words: 788 | < English (Canada) |




image9.png
Draw  z5 create Link

Text Box

orn to Run Reflective article example [Compatibility Mode] M

Home  Insert  Pagelayout  References  Mailings  Review  View Format N
- ‘Shape Fill - + — e - |,
22 7ot Direction & shap D o ) & & G Bring Forward - |2 Align flastan 2
. . . . . + | Zshape Outine - oo, P %D B send Backward - 2] Gro
‘Shadow 3D Position = ss8am 2
P change Shape * | crroqyc - Q Effects ~ 5 s WrapText© Sk Rotate - | =
Text Text Box Styles 7 Shadow Effects. 3-D Effects B In e with Text size
to Barry Magilo (ex:. T know!) for three asked if 1 hattosnwasmien oo )
hows staight to avoid lstening to was the only option E
“Ready, ok, 'm lad i endedup being  “new gil” Over tme, wlod ToRt |
Springsteen though! T doubt the Copa n my meaning of th %W Through
Cabana would have changed by life. fourth year song has change 'hrougt
“Bom to Run” was the fist song onthe of being in for me 1 @] Topand Bottom
CD and 1 Eistened to it on repeat for the that school. longer long |
N - N Trying to escape . Behind Text
T fnd ¢ suffocationof
It’s not easy to make m
5 5 =4 place in high school wasnt “small town” but rather | am building v F | 'n penaijiext
mistakes in a town where easy, but Bruce made me feel ife within this community.
everyone knowswho you like this was only a temporary Bruce’s anthem of freedom has take
Th vets situation and that I would be on a new meaning for me. While 1 hav4J  More Layout Options.
® are. There are no seci “ free of the high school world evolved from my days of longing to
and there is no such Sorever in two short years. He escape high school T am stll loking for
o o obvioudly didn't foresee my bigger and better things in my lfe. 1 am
thing as keeping future career plans that would il bom to run. I've just realized over
something quiet.” resultin my spendingthe restof  the years that I'tm ot bom to run avay
s e e my ifein the high school world from something, but rather towards my
entie night e by e T was feeling suffocated by a gols.
e e T o by e e town that knew more about me T never forget the fis time 1 heard
e and what T did than even I did this song, T think about it every time T
talking directly to my soul. When he said
ﬂﬂhhm"zhgmm“ The line “baby this town ips the. hear it. It was one of the first songs 1
o Tt s o, Spngmeen g bones fiom sour back, its leamed hows o play on uitar and he fist
e e s death tap, a sicide track. song 1 performed in public. It was the 3

youwve got to get out while

Page: 10f2 | Words: 20 | <3 English (Canada) |




image1.png
Home  Insert | Pagelayout | References  Mailings  Review  View
B colors - Pﬁ R ‘ V5 Breaks - \j @ B Indent spacing El ﬂ [ Bring Forward - |2 Align ~
[A]Fonts -~ #3 Line Numbers - Left 0cm B Before: 0 pt B & Send Backward - 18] Group
Themes Margins Orientation Size Columns Watermark Page  Page Position Wrap N
. [O]effects ~ = . . b Hyphenation ~ - Color - Borders | ¥ Right: 0 cm B After: 10 pt B Text . T Selection Pane Sk Rotate
Themes Last Custom Setting Page Background paragraph [ Arrange
Top: 05 m Bottom: 051 cm
Left: 064 cm Right: 063 cm
Normal
Top: 254cm  Bottom:  254cm
Left: 254cm Right: 254cm
itay?
Moderate
Top: 254cm  Bottom:  254cm
Left: 191 cm Right: 191 cm
Wide
Top: 254cm  Bottom: 254 cm d, babelannaknowif loveis real” Istll rememberthe firt time Iheard Springsteen
Left 503cm - Righti 5.0 cm ito Run.I'wasbackstage atthe HSB variety show listening to my disc man. Yes, one of
‘hadto actually puta CD in andrequired batteries,not charging.
Mirrored o
" setemsottom | 4sa ey teen's GreatestHits albumso T had somethingto liten to ther thanthe cheeileaders
Top | 23bem BOMOW 254 M [ o sright L probably would havelstened to By Manla e, L know? o
Estening to “Ready, ok!”, I'm glad it endedup being Springsteen though! 1 doubt the
nangedbylfe
Custom Margins.
‘Som o sus was e sust song on the CD and Ilistened to it onrepeat for the entire night. Inthe last line ofthe d
song he claims “tramps ke us, baby we were bom to run'”. It flt ke the music was talking directly tomy soul. B
‘When he saidit 1 fet e he was talking directly to me. And for some reason, Springsteen calling me a tramp didn't o

discourage my reaction to this ine. Then again... ook atthatman, Imeanzeally, it's Springsteen!

Page: 1 of 2 | Words: 775 | <8 English (Canada)





image2.png
Home

* cut

Times New Rom: ~ 10 -

2 copy
paste

~ < Format Painter

Clipboard

5

A

B I U -abe x. x| TNo Spacing ~ Heading 1

Font

Heading 2

Styles

25

Bornto Run...or Stay? 20

Line Spacing Options...

The song that
‘Add Space Before Paragraph

Tittany Dickie

“Ivapnaknowif love s wild, babe Ivana knowif love s real” Istil rememberthe first time Iheard Springsteen
sing theselyrics from “Bomto Run”. [ was backstage atthe HSB variety show lstening to my disc man. Yes, one of
thoselarge devices that youhadto actuallyputa CD in andrequired batteries, not charging.

My dadhadlent me Springsteen’s Greatest Hits albumso I had somethingto lsten to other thanthe cheerleaders
‘practicing their cheer for three hours straight. I probably would have Estened to Bamy Mapiloys (e, 1 know!) for
three hours straight to avoidlistening to “Ready, ok!”, I'm glad it endedup being Springsteen though! I doubt the
Copa Cabana wouldhave changedby ife

“Bomto Run'” was the first song on the CD and Ilistened to i onrepeat for the entire night. Inthe last e ofthe
song he claims “tramps ke us, baby we were bom to run”. It flt e the music was talking directly tomy soul.
‘When he saidit 1 fekt ke he was talking directly to me. And for some reason, Springsteen calling me a tramp did't
discourage my reaction to this Ene. Then again...look at thatman, Imeanteally, it's Springsteen!

& Find -

% Replace

Lt select -
Editing





image3.png
Margins Orientation

- color  Borders

spacing

5 Bring Forward -

= Breaks -

G Send Backward -

Watermark Page  Page

5 Hyphenation

Position Wrap

&4, Selection Pane

Page Background paragraph

Bornto Run...or Stay?
The song that

changed mylife

Titfany Dickie

“Ivapnaknowif love s wild, babe Ivamna knowif love s real” Istil rememberthe first time [heard Springsteen
sing theselyrics from “Bomto Run”. [ was backstage atthe HSB variety show lstening to my disc man. Yes, one of
thoselarge devices that youhadto actuallyputa CD in andrequired batteries, not charging.

My dadhadlent me Springsteen’s Greatest Hits albumso I had somethingto lsten to other thanthe cheerleaders
‘practicing their cheer for three hours straight. I probably would have Estened to Bamy Mapiloys (e, 1 know!) for
three hours straight to avoidlistening to “Ready, ok!”, I'm glad it endedup being Springsteen though! I doubt the
Copa Cabana wouldhave changedby ife

“Bomto Run'” was the first song on the CD and Ilistened to i onrepeat for the entire night. Inthe last e ofthe
song he claims “tramps ke us, baby we were bom to run”. It flt e the music was talking directly tomy soul.
‘When he saidit 1 fekt ke he was talking directly to me. And for some reason, Springsteen calling me a tramp did't
discourage my reaction to this Ene. Then again...look at thatman, Imeanteally, it's Springsteen!





image4.png
Insert  Pagelayout  References  Malings  Review  View

% cut . - A 4 Find -
’ Times NewRomi - 10« A & | Aa~ | &) AaBbCcDd | AaBbCcDd AaBhCc AaB 2 WP
B3 Copy = 3, Replace
Paste B I U - e X X c WA _ Change
= u 5 » A TNormal |TNoSpacing Heading 1 Heading 2 T <[ SN9E : elea -
Clipboard 5 Fort 5 Pargraph 5 stes 5| ediing
&
BorntoRun...or EEEETEE e
EEETe T e —
- .
Sta, that man, T mean really, it's
| il e ey
The song that e
it o T £ o o e o)
changedmylife i o s o [ e
cranged Erpe PNy [ ———
[ rimr = e [ v o
== - o5 i i e [ e i
‘Tiffany Dickie. an ant! It made me feel like
. there was so much out there for As time went by, this song
T samna know if love is wild, e to expesence if T couldjust e e
babe L ama Jaow iflove 5 oot e S re——
B B
tme 1 heard Sprngsteen sing iy terzirir - e oo 1)
these Iyris from “Bomto Run” 2 close community meant that escapethe constraints of my lfe
I was backstage at the HSB  you  condmt evem escape
variety show [Stening to my  yousel You can'tgo amyvhere My xebel subconscious kept
disc man. Yes, one of those Nithout someone knowing you replaying the image of me 3
large devices that you had ©©  or your parens, vhich made  9VRE into the sumset on the
actualy put a CD in and trying to re-invent yourself very back of a Harley escaping that :
e ot Tinonght 1 woadnerey  small town and the ramors and o
lose_the “good gil” rep, mo gossip that develop withinit. My -

Page: 1 of 2 | Words: 775/788 | <5 English (Canada)




